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CELCAT® Timetabler 7 
QLS Import/Export Plugin – Technical Reference 

 

Introduction 
The CELCAT Timetabler QLS Plugin is used to transfer data between CELCAT Timetabler 7 
and Agresso QL Students (QLS) software, and is designed to allow the two systems to operate 
together on shared data. The „plugin‟ is supplied as part of the CELCAT Timetabler 7 Client 
product and requires additional software support from Agresso Ltd. 

This document explains how to use the QLS Plugin and describes the data transfer mechanism 
it implements. Note that the QLS Plugin has been designed for general-purpose use, and 
where the functions it offers do not meet your needs you may wish to commission a bespoke 
plugin to cater for your exact requirements – contact CELCAT for more information. 

These notes are written from the perspective of a CELCAT Timetabler user, so we discuss 
importing data from QLS and exporting data from Timetabler. A familiarity with CELCAT 
Timetabler 7 and Agresso QLS is assumed. 

Running the Plugin 
The QLS Plugin is available from the Tools menu of the CELCAT Timetabler Client software. 

Select Tools | Timetable Utilities | Import to display the Import window as shown 
below. Then select the Distinction QLS item (Agresso was formerly known as “Distinction 
Systems”). 

 

Import Window 

The QLS Plugin comprises several tabbed pages each corresponding to a data type involved in 
the import/export function. You can use the View menu to hide or display relevant pages 
(e.g. if you never wish to import rooms into Timetabler you should hide the Room page). 
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QLS Plugin 

These are the data types that can be imported / exported: 

Import from QLS into CELCAT Timetabler 

Departments, Sites, Room Layouts, Rooms, Fixtures, Staff, Students, Areas of 
Study (“AOS”), Registers 

Export from CELCAT Timetabler into QLS 

Events 

The transfer of data between Agresso QLS and CELCAT Timetabler is illustrated in the 
following diagram: 
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Data Transfer 

Configuring the Plugin 
Select the Tools | Options command to display the Options window as shown below.  

 

Options Window 

Enable QLS Support 

“QLS Support” must be enabled for your timetable before you can begin to transfer data 
between the software systems.  

Technical note: Ticking the “QLS Support” checkbox enables a trigger 
in the Timetabler database called TG_EVENT_UPDATE_QLS. It is used 
to record details of event changes in the CT_EVENT_LOG table, which in 
turn is required when populating the list of changed events in the QLS 
Plugin‟s Event page. 
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QLS Academic Period 

The QLS Academic Period refers to the academic period (or year) in the QLS database. When 
importing data from QLS it is important to extract data that corresponds to the same time 
period as that of your CELCAT timetable. 

Auto generate register ID 

When this option is ticked, a QLS register ID is automatically generated when a new event is 
added into your timetable. 

Technical note: The TG_EVENT_INSERT_QLS trigger is enabled 
when the “Auto generate register ID” option is ticked. This performs the 
task of generating a register ID and inserting it into the event‟s 
original_id field. The register ID is created by taking the event‟s internal 
unique key value (an integer) and padding it to 12 characters using 
pseudo-random character values. 

The QLS register ID associated with a Timetabler event can be displayed in 
Timetabler’s event window for reference. See the Timetabler Client application 
(Tools | Options | General | Events | Show original ID) as shown below. 

 

Event Options 

Include suspended 

When enabled, this option ensures that suspended events are also included in the Event 
page. The default value is true. 

Include protected 

When enabled, this option ensures that protected events are also included in the Event page. 
The default value is true. 

Use Event Module / Use Event Group 

Specify whether CELCAT Timetabler modules or groups are used as the reference resource 
type when listing and exporting events. Your choice will depend on how you use these entities 
in your timetable. 

Other Options 

Further options are available on some of the QLS Plugin‟s tabbed pages. These are described 
below: 

Import room fixtures 

This checkbox appears on the Room page and should be ticked if you want to 
transfer room fixtures (items of equipment) from QLS into your timetable. 

Active/Inactive/Both 

This group of buttons appears on the AOS page and is used to specify what QLS Areas 
of Study to import into Timetabler. 

Import as Groups 
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This checkbox (on the AOS page) should be ticked if you want to import QLS Areas of 
Study as CELCAT Timetabler Groups. If the checkbox is left unticked, they are 
imported as Modules. 

Modified Since 

On the Register page, the “Modified since” control allows you to limit the display of 
QLS registers to those modified since the specified date (non-inclusive). 

Similarly, on the Event page, the “Modified since” control allows you to limit the 
display of Timetabler events to those modified since the specified date (non-
inclusive). However, note that if more than one Timetabler event corresponds to a 
single QLS register and one of these events has been changed since the specified date, 
all of these associated events will appear in the list.  

Register Description 

Use these controls on the Event page to specify how the QLS register description 
should be generated when exporting events from Timetabler. 

Event Category 

These controls on the Event page allow you to limit (by event category) the events 
that should be displayed. 

Data Mapping 
Data is effectively shared between CELCAT Timetabler and Agresso QLS, which requires a 
well-defined mapping of entities and their attributes between the two systems. The following 
table describes the shared entities and shows their correspondences. The resource data 
(rooms, staff, etc) originates in QLS and is only ever transferred one way (from QLS into 
Timetabler). However, the event data can be transferred in both directions. This allows 
CELCAT Timetabler events to be used to generate register headers in QLS, and QLS registers 
to be used to create events in Timetabler. 

Technical note: In all cases, the CELCAT Timetabler origin_id and 
original_id fields are used to record the origin of the record. For 
example, when a room is imported from QLS, the room‟s code (as used to 
uniquely identify the room in QLS) is stored in the room‟s original_id 
field (in Timetabler’s room record). The QLS Plugin automatically 
creates a single origin_id value for all of your imported records (allowing 
the QLS Plugin to distinguish between multiple import sources). The 
result is that the QLS Plugin can easily match items and manage 
subsequent changes to your imported records. 

Departments 

From Agresso QLS To CELCAT Timetabler Comments 

Code or Description Name Either the QLS department code 
or description is used depending 
on your setting of the relevant 
QLS export option 

Code Original ID  

Note that if you change a department‟s Name in Timetabler and re-run the QLS Plugin, the 
Name will revert to its value in QLS. QLS is therefore considered the master source of 
department names. 

Rooms 

From Agresso QLS To CELCAT Timetabler Comments 

Code Unique name  

Description Name  
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Telephone Telephone  

Department code Department ID Via link to department entity 

Site Site ID Via link to site entity 

Area Area  

Code Original ID  

Note that when changes are made to any of the above room fields in Timetabler, these 
changes will be overwritten the next time the QLS Plugin is run and the room imported. Thus 
QLS is considered the master source of this room information. However, if other attributes of 
the room are modified in Timetabler (such as the default capacity, access for the disabled, etc) 
then these attributes are retained. 

Room Layouts 

From Agresso QLS To CELCAT Timetabler Comments 

Name + Description Name  

Description Description  

Name Original ID  

When rooms are imported from QLS, any associated room layouts and capacities are also 
imported. Although a single room in Timetabler can have multiple layouts, the QLS Plugin 
can only import a single layout from QLS. If you add extra layouts for a room in Timetabler 
then these are retained and are not overwritten when the QLS Plugin next runs and the room 
re-imported. 

Sites 

From Agresso QLS To CELCAT Timetabler Comments 

Name Name Derived directly from the QLS 
room record (the Site field) 
rather than from a separate „Site‟ 
table 

Name Original ID  

A site is an attribute of the „room‟ entity. If the name of a site is changed in Timetabler, it can 
still be matched by the unique_id field and is overwritten by the QLS data when the QLS 
Plugin is next run. 

Fixtures 

From Agresso QLS To CELCAT Timetabler Comments 

Description Name  

Code Original ID  

A fixture is a fixture or fitting in a room. See Inventory below. Note that the Fixtures and 
Inventory are only imported from QLS if the Import room fixtures checkbox on the QLS 
Plugin‟s Room page is ticked. 

Inventory 

From Agresso QLS To CELCAT Timetabler Comments 

Room Code Room Original ID  

Fixture Code Fixture Original ID  

Quantity Quantity  
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A room inventory is the list of fixtures associated with each room. 

Staff 

From Agresso QLS To CELCAT Timetabler Comments 

Code Unique name  

Name Name  

Honorific Title  

Address Address1 The QLS staff address is 
truncated to 64 characters and 
placed in the Timetabler 
address1 column 

Department code Department ID Via link to department entity 

Staff Office Room ID Via link to room entity 

Home tel Home tel  

WWW WWW  

Code Original ID  

Note that when changes are made to any of the above staff fields in Timetabler, these changes 
will be overwritten the next time the QLS Plugin is run and the member of staff imported. 
Thus QLS is considered the master source of this staff information. However, if other 
attributes of the staff record are modified in Timetabler (such as the tag values, special needs 
flags, etc) then these attributes are retained. 

Students 

From Agresso QLS To CELCAT Timetabler Comments 

Code Unique name  

Name Name The QLS student name is 
truncated to 128 characters 

Date of birth Date of birth  

Gender Sex  

Code Original ID  

If a student record is modified in Timetabler, your changes will be overwritten when the QLS 
Plugin is next run and the student record imported. QLS is considered the master source of 
these student attributes. 

Areas of Study 

From Agresso QLS To CELCAT Timetabler Comments 

Code + Separator + Period Unique name Note the fabrication of the 
unique identifier from aos code 
and period of study separated by 
the separator character 

Description Name Course description truncated to 
128 characters 

Academic year Year  

Department code Department ID Via link to department entity 

WWW WWW  

Code + Separator + Period Original ID  
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An “Area of Study” is QLS terminology and usually corresponds to a CELCAT Timetabler 
“Module” or “Group” (depending upon your setting of the Import as groups checkbox in 
the QLS Plugin‟s AOS page). QLS is considered the master source of AOS data. 

Technical note: When importing resource records from QLS into 
Timetabler, care is taken to ensure that inserts and updates are only 
performed when absolutely necessary. For example, when importing a 
room from QLS, if it already exists in Timetabler (as determined by the 
original_id value), the record will be checked to see if any changes are 
required (i.e. field values have been modified in QLS) and only updated if 
necessary. 

Registers 

From Agresso QLS To CELCAT Timetabler Comments 

Day of week Day of week  

Start time Start time  

End time End time  

Department code Department ID Via link to department entity 

Weeks Weeks  

Register ID Original ID  

When importing registers, the QLS Plugin matches registers against events using the QLS 
„Register ID‟. This value is stored in the original_id field of Timetabler events. See below 
under “Registers and Events” for more information. 

Events 

From CELCAT Timetabler To Agresso QLS Comments 

Day of week Day of week  

Start time Start time  

End time End time  

Register ID Register ID  

Description Description  

Department Department  

 

Resource Assignments 

Resource assignments are simply the lists of resources allocated to events/registers. These are 
transferred when importing registers from QLS and when exporting events from Timetabler. 

Registers and Events 
The QLS Plugin provides for importing core resources (such as rooms, staff, etc) from QLS, 
but this data is never exported back from Timetabler to QLS. The situation is different with 
event/register data, which can be transferred in both directions. This section describes the 
way Agresso QLS „Registers‟ and CELCAT Timetabler „Events‟ interact. 

QLS Registers 

A QLS register comprises a register header identified by a „Register ID‟ and any number of 
associated register profiles. Each profile contains detailed information about the register in a 
specified span of contiguous weeks. Profile records never contain overlapping weeks. This 
arrangement is depicted below. 



 

 9 

 

Additionally, each of the profiles contains a „fixed‟ set of resources that participate in the 
register in all weeks of the profile. 

CELCAT Timetabler Events 

A Timetabler event occurs on a particular day of the week and at specified start and end times. 
It can run in any of the weeks of your timetable (not just contiguous spans). Furthermore, 
resources (e.g. staff, rooms etc) allocated to an event can participate in any or all of the event‟s 
weeks. 

Often there is a one-to-one relationship between Timetabler events and QLS registers, but the 
above description shows that this may not always be the case. For example, in the QLS 
register depicted above, the three profiles could not be accommodated in a single event since 
they occur on different days (and at different times). So when importing a register like this, 
the QLS Plugin must generate three events – one for each of the profiles. The QLS Plugin 
manages the complexity of mapping registers to events and vice-versa. In particular, when 
importing registers: 

1. Profiles are matched against existing events and/or new events are created to 
accommodate the data. 

2. Extraneous events (which are no longer required to represent the register data) are 
removed. Although this is not an error condition, a message is provided in the error 
log when this happens. 

When exporting events from Timetabler: 

1. Care is taken to ensure that registers are created in QLS with contiguous week profiles 
and where the resources are allocated in all weeks of the profile. 

The consequence of this is that you are free to split events in Timetabler (where the newly 
created events will automatically retain the original register ID), allocate a resource to a 
subset of an event‟s weeks, etc, without worrying about the transfer of the data to QLS – the 
Plugin manages this complexity for you. 

An Event Export Example 

The following example serves to illustrate how a complex Timetabler event is processed 
during the export operation. 

Part of the Timetabler event description: 

Day  Monday 

Time  9:00 – 10:00 

Weeks  1-10, 20-30 

Rooms  A101 (wks 1-5), B111 (wks 6-10, 20-30) 

Staff  Jones (wks 1-10), Smith (wks 20-30) 
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Note that the event has two non-contiguous week blocks (1-10 and 20-30), and that the 
event‟s resources vary from week to week. 

When exporting this event to QLS, the QLS Plugin partitions the event thus: 

1. Weeks 1-5 (Room A101, Staff Jones) 

2. Weeks 6-10 (Room B111, Staff Jones) 

3. Weeks 20-30 (Room B111, Staff Smith) 

These partitions correspond to the QLS register profiles that are created. 

A Register Import Example 

In this example, a QLS register is processed during the Import Register operation. 

The QLS register comprises the following profiles: 

1. Monday, 10:00-11:00, Weeks 1-5. Room X433, Staff Wright 

2. Monday, 10:00-11:00, Weeks 10-20. Room X433, Staff Street 

3. Wednesday, 10:00-11:00, Weeks 21-30. Room W277, Staff Wright 

When importing this register into Timetabler, the QLS Plugin builds the following two events: 

1. Monday, 10:00-11:00, Weeks 1-5, 10-20. Room X433, Staff Wright (wks 1-5), 
Street (wks 10-20) 

2. Wednesday, 10:00-11:00, Weeks 21-30. Room W277, Staff Wright 

Note how the first two register profiles can be combined into a single event because the day 
and times are identical. 

Filtering Lists 
The QLS Plugin has a popup menu on each page that is accessed using the right mouse 
button. The menus have commands to make selections, filter the lists according to certain 
criteria, etc. For example, the Staff page popup menu shown below can be used to limit the 
list of QLS staff to those that have changed (i.e. where the record values differ from those 
currently in your timetable). 
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Synchronising 
Select the File menu, Synchronise command to run the QLS Plugin. The sequence of 
operations is as follows: 

1. Check for Duplicate Original ID Values 

A check is performed to ensure that there are no duplicate original_id values for 
resources in the Timetabler database.  

Each resource record in Timetabler (room, staff etc) has a field called “original_id” 
which is used in conjunction with an “origin_id” field to identify the origin of the 
record. When resources are imported into Timetabler from QLS the original_id field 
is used to store an ID value that uniquely identifies the record in QLS. It is therefore 
important that there are no duplicate original_id value in the Timetabler records. If 
duplicates are found, details are written to the error log and the whole process is 
aborted. 

2.  Import Departments 

The QLS department records are imported. All departments are processed (there is no 
way to select which departments to import). Departments are only imported if you 
have one or more of the following pages enabled (not hidden): Room, Staff, 
Student, AOS. 

3. Import Sites 

The QLS site records are imported (unless the Room page is hidden). 

4. Import Room Layouts 

The QLS room layout records are imported (unless the Room page is hidden). These 
are simply the room layout types that are in use by the rooms that you wish to import. 
If you do not select any rooms to be imported then no layouts will be processed either. 

5. Import Rooms 

The selected QLS rooms are imported. 
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6. Import Fixtures 

The QLS equipment records are imported. 

7. Import Inventory 

The QLS inventory is imported (the details of the fixtures in each room). 

8. Import Staff 

The selected QLS staff records are imported. 

9. Import Students 

The selected QLS student records are imported. 

10. Import Area of Study 

The selected QLS „area of study‟ records are imported. 

11. Import Registers 

The selected QLS registers are imported, creating or updating events in Timetabler. 
Note that when importing registers, if a resource assigned to the register does not 
exist it will be ignored. 

12. Export Registers 

The selected Timetabler events are exported to QLS, creating registers in QLS. 

Errors 
If errors are detected during the Synchronisation process, a log file is created which can be 
viewed using the View menu, Error Log command. 

There follows a list of the error messages that may appear in the log: 

Field is too long and has been truncated 

When importing data from QLS, if the value is too long to store in the CELCAT Timetabler 
database, it will be truncated. The limitations are as follows: 

Student names – 128 characters 

AOS descriptions – 128 characters 

Events associated with register „xxx‟ have overlapping weeks. Register has not 
been exported 

Several Timetabler events are associated with the single register „xxx‟ (this can occur for 
example when an event is split). You can only export one or more of these events if their 
weeks do not overlap. 

Register „xxx‟ belongs to a department that doesn't exist in QLS 

When exporting events to QLS, if an event belongs to a department that doesn‟t exist in QLS 
then the above error is reported. Note that the event is still exported but without a department 
attribute. 

No matching event was found for register: „xxx‟ 

When importing registers into CELCAT Timetabler, the above error is reported if more than 
one event exists for a register, but the QLS Plugin has been unable to match the register to one 
of these events. A „match‟ is based on a temporal comparison – day of the week, weeks and 
start/end times. This means that the event‟s temporal attributes have been modified in 
CELCAT Timetabler. In these circumstances, the QLS Plugin will create a new event for the 
register and discard the original event (unless the original event is matched with another 
profile in the same register). 

Another entry for register „xxx‟ was also found and included in the import 
procedure 
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When importing registers, a register ID may appear multiple times in the Register page. This 
is an indication that the register contains a number of profiles (see above under “Registers 
and Events”). If you select just one of these rows then the QLS Plugin automatically includes 
the other profiles too and inserts the above information into the error log. 

Another event for register „xxx‟ was also found and included in the export 
procedure 

When exporting events, a number of listed events may correspond to a single register ID. If 
you have only selected one of these rows then the QLS Plugin automatically includes other 
events with the same register ID. This ensures that the complete „register‟ is transferred to 
QLS. Note that in some cases a related event may not appear on the Event Page because it 
hasn‟t been modified since the specified „changed since‟ date. If this is the case, the QLS 
Plugin still detects the condition and automatically includes all appropriate events for you. 

Cannot update Room “ABC” – error message… 

Cannot insert Room “ABC” – error message… 

These messages (and variations) describe generic errors raised by the database server 
software. Please see your SQL Server documentation for more information. 

Duplicate Room record found – “ABC” (there are 2 duplicates) 

This message (and variations) means that one or more of your Timetabler resource records 
have duplicate original_id values. Each resource record in Timetabler (room, staff etc) has a 
field called “original_id” which is used in conjunction with an “origin_id” field to identify the 
origin of the record. When resources are imported into Timetabler from QLS the original_id 
field is used to store an ID value that uniquely identifies the record in QLS. You should 
remove any duplication. 

Event xxx preserved 

When registers are imported into Timetabler, sometimes an event is deemed superfluous and 
is earmarked for removal. However, if there are any problems creating new event(s) for the 
register, then the specified event is preserved. 

The following event(s) were deleted during import of register… 

This information message is used to list the IDs of events that have been deleted during the 
import of registers into Timetabler. 

Deleted Records 
When resource data (rooms, staff etc) is deleted in QLS, the Plugin does not automatically 
remove any corresponding data records in Timetabler. This is by design. If you need 
functionality that does not exist in the QLS Plugin please contact us to discuss your 
requirements. 
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